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About this Manual 
 

The Oracle Financial Services Channel Analytics will be utilized for Channel performance and 
operational metrics to optimize channel capacity (transaction loads on ATM, Branch, Call 
center, Chat, etc), Cross-channel performance analysis (customer preferences for specific 
channels for different transactions) to enable migration to self-servicing on low-cost channels, 
Understand any underlying customer skews in channel preferences i.e. affinity of most 
profitable segment for certain channels or increased frequency of touch-points in specific 
customer segments etc, Branch transaction analysis, ATM/POS transaction analysis, 
Optimize Channel investments to ensure high customer satisfaction and hence engagement. 

Audience 

This Manual is meant for use by the Oracle Financial Services Analytical Applications 
Infrastructure System Administrator. It provides step-by-step instructions necessary for 
installing the Oracle Financial Services Channel Analytics v6.0 Product.  

Scope 

This manual provides a step-wise instruction to install the Oracle Financial Services Channel 
Analytics Product in an existing Oracle Financial Services Analytical Applications 
Infrastructure hosted in Oracle 11g R2 (11.2.0.2.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters. 

Pre Requisites section identifies the hardware and base software environment that is 
required for a successful installation & functioning of the Oracle Financial Services Analytical 
Applications Infrastructure Solution.  

Installing Oracle Financial Services Channel Analytics v6.0 Product section details the 
pre-installation activities followed by a step-by-step instruction on the various installation 
options. 

Post installation Activities section details the steps that are required to be performed after a 
successful installation of the Oracle Financial Services Analytical Applications Infrastructure 
Solution. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics.  

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

NOTE 

o It is important that the password should be 6 characters long. If you do not 
adhere to this pre-requisite, you will see a system message that reads Password 
must be at least 6 characters long. 
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Pre-Requisites 
The installation process requires certain environmental variables to be set prior to starting the 
installation. You must ensure that these requirements are met before starting the installation. 
You are requested to refer to the Release Notes for the latest updates on hardware or 
software requirements and the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of Oracle Financial Services Channel Analytics v6.0 Product requires the Oracle 
11g R2 (11.2.0.2.0) version of Oracle Financial Services Analytical Applications 
Infrastructure v7.3, to be installed in either a single-tier or multi-tier environment.  It is implicit 
that all base software versions and patch levels required by the Oracle Financial Services 
Analytical Applications Infrastructure 7.3 is available and adhered to. 

  NOTE 

o If you are doing an up-gradation please make sure that OFSAAI has been 
upgraded from v7.2 (Release no – 7.2.10) to v7.3.  

o The Oracle Financial Services Channel Analytics v6.0 installer download contains 

only the ERwin XML file that is required for uploading the model. This file is 

sufficient to install the v6.0 product. However, this XML file cannot be opened in 

the ERwin Data modeler tool and hence cannot be used for any data model 

customization. ERwin file is delivered as a patch and need to be downloaded 

separately. This ERwin file should be used for any customization of the data 

model. Reference bug / patch where ERwin file can be downloaded is Bug - 

14354552.  

The Oracle 11g R2 (11.2.0.2.0) version of Oracle Financial Services Analytical Applications 
Infrastructure v7.3 and OBIEE 11.1.1.6.0 on any supported operating system once installed 
must be configured. 

After Installation of OBIEE 11.1.1.6.0, following 3 patches are highly recommended for all the 
customers who are using Oracle Business Intelligence Enterprise Edition 11.1.1.6.0 which 
can be downloaded from Oracle support site. 

• 13742915 

• 13388423 

• 14003822 

Front-End Access 

• Internet Explorer 8.0/9.0 

• Java Plug-in 1.6.0_21 

• Acrobat Reader 8.0 

• The screen resolutions supported are 1024*768 and 1280*1024 

 NOTE 

o Ensure that Java Plug-in is enabled in the browser settings. 
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Installing Oracle Financial Services Channel Analytics 
v6.0 Product 
Pre-Installation Activities  

The following is the Pre Installation checklist to ensure the readiness to start installing Oracle Financial 
Services Channel Analytics Product: 

o Oracle Financial Services Analytical Applications Infrastructure v7.3 must be 
successfully installed on Oracle 11gR2 (RAC) (11.2.0.2.0). 

o If Infrastructure installation is on multitier environment, Execute the following 
commands in the DB Layer terminal  

o chmod -R 777 < ftpshare folder >  

o Navigate to ftpshare folder and set the umask shown as below, this will make 
sure all the new files created will have 666 file permission.  

- cd < ftpshare folder >  

- umask 0000 

o The Config and application schema should be two distinct oracle database 
users. 

o Please execute the following grants in config schema. Please replace 
<ORACLE_USER> with application schema user. 

- grant select on METADATA_MASTER to <ORACLE_USER> 

- grant select on METADATA_ELEMENT_MASTER to 
<ORACLE_USER> 

- grant select on METADATA_LOCALE_MASTER to  
<ORACLE_USER> 

o Oracle database User for Application schema should have the below grants 

- grant create session to <ORACLE_USER>; 

- grant create ANY INDEX to <ORACLE_USER>;  

- grant create PROCEDURE to <ORACLE_USER>;  

- grant create SEQUENCE to <ORACLE_USER>;  

- grant DEBUG CONNECT SESSION to <ORACLE_USER>;  

- grant create TABLE to <ORACLE_USER>;  

- grant create VIEW to <ORACLE_USER>;  

- grant create trigger to <ORACLE_USER>; 

- grant create type to <oracle_user>; 

- grant select on sys.v_$parameter TO <oracle_user>: 

o Please copy the entire Oracle Financial Services Channel Analytics  v6.0 
installer download directory to the server location (Including the DataModel 
directory). Please give read, write and execute permission to all the files 
present in this directory. 

o Please specify the log file path and name in the log4j.xml. Please update the 
“value” attribute marked in the following picture 
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Figure 1: Log4j.xml file configuration 

 

o Please make sure the path given in the log4j.xml file has read/write/execute 
permission. 

o Please execute the “config_table_privileges_for_application_user.sql” script 
in configuration schema. This file will be present inside $FIC_HOME 
directory. 

o Please make sure FICServer is up and running before proceeding for 
installation. 
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Oracle Financial Services Channel Analytics 
v6.0 Product Installation 
The Oracle Financial Services Analytical Applications Infrastructure Product comprises of 
components that are installed in Web, Application & Database layer.  Hence if you have 
installed Oracle Financial Services Analytical Applications Infrastructure 7.3 in a multi-tier 
architecture, the Oracle Financial Services Channel Analytics Product installer must be 
invoked on each of the machines that host the Oracle Financial Services Analytical 
Applications Infrastructure tier.   

For a Single-tier installation, the installer is required to be invoked only once on the machine 
that hosts all the Oracle Financial Services Analytical Applications Infrastructure tiers.   

This section describes the installation process where the Three Product setup components 
are installed on separate machines in with the Product installation on separate machines. 
Machine A will be used to install Product Application Layer components, Machine B will be 
used to install Product Database Layer components and Machine C will be used to install 
Product Web Layer components.  

NOTE 

o This section holds applicable if Oracle Financial Services Analytical Applications 
Infrastructure v7.3 is installed on Oracle 11g on separate machines A and B 
respectively. 

o Refer to section on “Silent Installation”, if a silent installation is required. 
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Machine A – Product App Layer 

Step 1 

To begin Oracle Financial Services Channel Analytics product installation, execute Setup.sh. 

 

Figure 2: Installation Splash Screen 

Step 2 

 

Figure 3: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 
installation.  Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Please choose the log mode for this installer.  



 

7 
 

 

Figure 4: Log Mode Option Screen 

 

Step 4 

Please provide the 9 digit Customer Identification number provided during the OFSAAI 
installation.  

 

Figure 5: Customer ID Input Screen 

 

 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information.   

Select the appropriate Oracle Financial Services Analytical Applications Infrastructure layer 
that has been installed on the machine.  

Example AppLayer 

 
Figure 6: Pre Setup Information Screen – Choose Layer to Install 

Along with appropriate Oracle Financial Services Analytical Applications Infrastructure layer. 

NOTE 

o For a single-tier Oracle Financial Services Analytical Applications Infrastructure 
v7.3 installation, you must select App Layer and DB Layer.  For a multi-tier Oracle 
Financial Services Analytical Applications Infrastructure v7.3 installation, select 
the corresponding layer installed on the machine.   
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Step 6 

This panel seeks infromation on whether a new infodom has to be created or the existing 
infodom to be used for apps installtion. Please choose the desired option. 

 

Figure 7: Pre Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option “New Infodom” was chosen in the previous panel then the following panel will be 
next displayed which will seek information of the following details to create infodom. 

Please specify a DB name for the new infodom. Please make a TNS entry with the DB name 
specified in the tnsname.ora file in the oracle server. 

Please enter the newly created application schema user name, password, jdbc url in relevant 
fields. 

Click Next to continue 

 

Figure 8: Database details for the new Infodom 
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Step 7-ii 

If the option “New Infodom” was chosen in the previous panel then the following panel will be 
displayed following the panel 7-i which will seek further information of the following details to 
create infodom. 

Please specify the name and description for the new infodom to be created.  

Please specify a segment name to be created. 

Note : Segment name should not exceed 10 Characters 

Also specify the Application server and database server log path for infodom maintenance (to 
be created) 

 

Figure 9: Infodom details for creation of new Infodom 

  NOTE 

o The Oracle Financial Services Analytical Applications Infrastructure user must 
have a role that is able to perform Add/Modify functions for Oracle Financial 
Services Channel Analytics  metadata.   

Click Next to continue.  

Step 7-iii 

If the option “New Infodom” was chosen in the previous panel then the following panel will be 
displayed following the panel 7-ii which will display the pre-infodom creation details. Please 
check and verify all the details before proceeding to the next step. 
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Figure 10: Pre Infodom Creation Summary 

 

Click Next to continue creation of information domain. A new information domain will be 
created on clicking Next. 

Step 7-iv 

If the option “Existing Infodom” was chosen in the Step 6 then the following panel will be 
displayed which will prompt to select the infodom from list of infodoms present in the setup, 
enter segment code and enter the application schema’s TNS name. 

Segment code should not exceed 10 characters 

 

 

Figure 11: Installation in Progress 

Step 8 

Oracle Financial Services Channel Analytics v6.0 data model is packaged as part of Oracle 
Financial Services Channel Analytics v6.0 product installer and will be installed as part of the 
upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 
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Figure 12: Pre-Setup Information 

Clicking ‘No’ implies that Oracle Financial Services Channel Analytics v6.0 model has been 
uploaded into information domain prior to this installation. 

Clicking ‘Yes’ will proceed with the Oracle Financial Services Channel Analytics v6.0 model 
upload process as part of the installation. 

 

If the user selects “Yes”, Step 9 and 10 will be performed. 

Upon selecting “No..”, Step 9 to 10 will be skipped. 

Click Next to proceed. 

 

Step - 9 

The following panel prompts the user to choose whether the released version of Datamodel or 
the customized datamodel to be uploaded. 

On selecting ‘Released Data Model’ option, installer uploads the Oracle Financial Services 
Channel Analytics v6.0 data model that is packaged as part of the Oracle Financial Services 
Channel Analytics  v6.0 product.  

On selecting ‘Customized Data Model’ option, installer allows the user to select the data 
model.Please choose desired option. 

Click Next to proceed. 
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Figure 13: Pre – Setup information 

Step – 10 

If the option “Customized Data Model” was chosen then the following panel will be displayed 
prompting user to select the customized data model located in the machine. 

Please choose the customised datamodel file from the server. 

Note:  

o The data model xml file should be available in the server. 

o In case the installation is being performed on an existing information domain, 
the data model that is planned to be selected in this panel should be merged 
with the data model that was previously uploaded in the information domain. 

In case the installation is being performed on a new information domain, data model that is 
either customized or merged with other data models can be selected in this panel. 

 

Figure 14: Pre – Setup information 

Step -11 

The following panel displays pre-model upload details. 

Please verify the details before proceeding to the next step. 
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Click Next to proceed for model upload. 

 
Figure 15: Pre – Model Upload Summary 

 

Clicking on ‘Next’ will start the model upload process. This process will take some time 
depending on the size of the data model and available physical memory in the environment. 
User will not be able to take any further action on the screen, until the model upload process 
is complete. Also, this step cannot be rolled back. 

If the model upload fails, then a pop-up message with relevant error and the log file path will 
be displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 
successful and the installer takes the user to next step. 

Note: 

Some of the common errors during model upload are 

o Insufficient heap memory on the client machine 

o Possible reason/resolution: The java memory settings in “reveleusstartup.sh” 
located in $FIC_APP_HOME/common/FICServer/bin directory should be 
increased. 

o Error while getting the Erwin File path  

o Possible reason/resolution: Restart the FICServer. 

o Error in Upload Operation :  

o  “FAILED WHILE SUPER CATEGORY - SUB CATEGORY RELATIONS 
HANDLING DELETING” 

o Possible reason/resolution: Incorrect Erwin.xsl file version in 
$FIC_APP_HOME/common/FICServer/conf directory.  

 

o Incremental/Sliced model upload might give errors in case there are NOT 
NULL columns that are being added to a table that already has rows or if the 
columns that are being dropped have values. Check the data model changes 
excel file for any such cases. In such a case, take a backup of the table and 
truncate the table. Insert records back into the table with a default value for 
the NOT NULL column. 
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Navigate to the previous screen and proceed with the steps mentioned above. 

 

Step - 12 

The following panel seeks input from the user on whether to create new ETL 
application/source pair or use an existing one. 

In case of upgrade, if customer selects an existing application/source pair, then existing ETL 
definitions under the source will be over-written with the packaged definitions. Customer can 
also choose to create a new application / source pair and then merge the changes between 
the packaged definition and their existing definitions offline. 

Please choose a desired option. 

Click Next to continue 

 

Figure 16: Pre – Setup Information 

Step 13-i 

If the option ”New application/source pair” was chosen then the following panel will displayed 
seeking the application and source name for creation of the same. 

Please specify all the details required for application and source creation. 

Click Next to proceed. 

Clicking ‘Next’ will create application and source within OFSAAI. Source model will also be 
generated. This process will take some time depending on the number of entities / attributes 
in the application schema. This step cannot be rolled back. 
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Figure 17: Pre – Setup Information 

 Note:  

ETL Source will be created pointing to the information domain (application schema) 
that is specified during the installation. 

 

Step 13-ii 

If the option “Existing application/source pair” was chosen the following panel willl be 
displayed prompting user to select app/source pair from the list of pairs already present. 

Please choose the desired ETL application/source pair into which ETL definitions will be 
deployed. 

Click Next to proceed 

 

Figure 18: Pre – Setup Information 
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Step 14 

Please specify the OFSAAI user id. 

 
Figure 18: Pre Setup Information Screen 

 

Click Next to continue. 

 

Step 15 

This panel displays all the pre-installation summary. Please verify all details and proceed. 

Click Install to proceed. 

 
Figure 19: Pre – Install Summary 

 

Step 16 

This panel displays the installation process. Please wait until it completes. 
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Figure 20: Installation is in progress 

 

Step 17 

The following screen displays the completion of installation of the Oracle Financial Services 
Channel Analytics Product Setup. 

Click Done to exit. 

 
Figure 21: Installation Complete 
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Machine B – Product Database Layer 

Step 1 

To begin Oracle Financial Services Channel Anaytics product installation, execute Setup.sh. 

 

Figure 22: Installation Splash Screen 

Step 2 

 

Figure 23: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 
installation.  Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Please choose the log mode for this installer. Click Next to proceed. 



 

20 
 

 

Figure 24: Log Mode Option Screen 

 

Step 4 

Please provide the 9 digit Customer Identification number provided during the OFSAAI 
installation.  

 

Figure 25: Customer ID Input Screen 

 

 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information.   

Select the appropriate Oracle Financial Services Analytical Applications Infrastructure layer 
that has been installed on the machine.  

Example Database Layer 

 
Figure 26: Pre Setup Information Screen – Choose Layer to Install 

Along with appropriate Oracle Financial Services Analytical Applications Infrastructure layer  

NOTE 

o For a single-tier Oracle Financial Services Analytical Applications Infrastructure 
v7.3 installation, you must select App Layer, DB Layer. For a multi-tier Oracle 
Financial Services Analytical Applications Infrastructure v7.3 installation, select 
the corresponding layer installed on the machine.   

Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 
infodoms present in the setup, enter segment code and enter the application schema’s TNS 
name. 

Segment code should not exceed 10 characters 
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Figure 27: Pre Setup Information Screen 

Step 7 

Please specify the OFSAAI user id. 

 
Figure 28: Pre Setup Information Screen 

Click Next to continue. 

Step 8 

 

This panel displays all the pre-installation summary. Please verify all details and proceed. 

Click Install to proceed. 
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Figure 29: Pre – Install Summary 

 

Step 9 

This panel displays the installation process. Please wait until it completes. 

 
Figure 30: Installation is in progress 

Step 10 

The following screen displays the completion of installation of the Oracle Financial Services 
Channel Analytics Product Setup. 

Click Done to exit. 
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Figure 31: Installation Complete 
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Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 
proper values, before attempting to install using the silent mode. 

 

How to install in Silent Mode 
- The installer folder contains a template file “Silent.template” 
- Create a copy of this file and rename the copy as “Silent.props” 
- Edit the file “Silent.props” and specify the parameters as per the requirements 
- On the UNIX Command prompt, execute the following command 

o “Setup.sh SILENT” 
Refer to the console log [or the file preinstall.log] for any error messages. 
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The following table lists all the properties that need to be specified: 

 

Property Name Description of Property Permissible 
values  

Comments 

LOG_MODE Mode for logging 0 = Debug  
1= General 

Optional; 
Default : 0 

CUSTOMER_ID Customer id specified while 
installing OFSAAI 

Not Applicable MANDATORY 

INSTALL_DB Install database-tier 
components 

0 = No 
1 = Yes 

Default : 0 

INSTALL_APP Install Application-tier 
components be installed 

0 = No 
1 = Yes 

Default : 0 

INFODOM_NAME Information Domain(infodom) Not Applicable MANDATORY 

SEGMENT_CODE Segment Code Not Applicable MANDATORY 

Segment Code should 
not exceed 10 characters 

TABLESPACE Tablespace name Not Applicable MANDATORY 

INFODOM_TYPE New Infodom or Existing 
Infodom 

0 = New 
1 = Existing 

# Specify Infodom Type 

Mandatory if this an App 
Layer Installation and 
option selected for 
INSTALL_APP=1 

APPL_TNS TNS Name of the Infodom 
database 

Not Applicable MANDATORY 

APPL_USER User-id of the Database 
Schema for new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_PWD Password  of the Database 
Schema for new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 
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# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_URL JDBC Connection String of the 
the Database Schema for new 
Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

RAC_STATUS whether the Database Schema 
for new Infodom is a RAC 
database 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

INFODOM_DESC Description for the Database 
Schema for new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APALM P_LOG_PATH= Infodom Maintenance log 
path(to be created) for the new 
Infodom for applayer 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

DBFTP_LOG_PATH Infodom Maintenance log 
path(to be created) for the new 
Infodom for DBLayer 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a new 
infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

UPLOAD_MODEL whether you want to perform 
Model Upload 

0 = No 
1 = yes 

Mandatory if 
INSTALL_APP=1 
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MODEL_TYPE Released datamodel or 
Customized datamodel 

0 = released 
1 = customized 

Mandatory if 
INSTALL_APP=1 

DATAMODEL the path  for the customized 
datamodel 

Not Applicable # Mandatory only in the 
case  of uploading the 
customized datamodel 

# Option selected for 
MODEL_TYPE=1 

DM_DIRECTORY the file name for the 
customized datamodel 

Not Applicable # Mandatory only in the 
case  of uploading the 
customized datamodel 

# Option selected for 
MODEL_TYPE=1 

ETL_APP_NAME The ETL application name Not Applicable # Mandatory if this an 
App Layer installation 

# Option selected for 
INSTALL_APP=1 

ETL_SRC_NAME The ETL Source into which the 
Table-2-Table ETL definitions 
on staging tables will be 
deployed. 

Not Applicable This Source must be 
mapped to the above 
ETL Application 

ETL_APPSRC_TYPE Create new ETL App/Src pair 
or use an existing one 

0 = New 
1 = Existing 

# Mandatory if this an 
App Layer installation 

# Option selected for 
INSTALL_APP=1 

# 0 = If you want to 
create a new ETL 
app/src pair 

# 1 = If you want to use 
an existing pair 

ETL_APP_DESC Please give description for the 
ETL App 

Not Applicable # Mandatory if you want 
to create new ETL 
app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=0 

ETL_SRC_DESC Please give description for the 
ETL Src 

Not Applicable # Mandatory if you want 
to create new ETL 
app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=0 
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Post Installation Activities 
Oracle Financial Services Analytical Applications Infrastructure Server Memory Configuration 

The Oracle Financial Services Analytical Applications Infrastructure Application Server is 
started using reveleusstartup.sh. This file can be edited for setting customized memory 
settings, garbage collector settings depending on the available hardware configuration. 
Please raise an SR in support.oracle.com if you have any queries related to EPM 
applications. 

Once the installation of Oracle Financial Services Channel Analytics Product is completed, 
you must perform the following steps. 

o Check the Log file (The path and file name specified in the log4j.xml). 

o Ignore the following errors in the log file: 

- Error: ORA-02260: table can have only one primary key. 

- Error: ORA-00955: name is already used by an existing object. 

- Error: ORA-00001: unique constraint (<<UNIQUE KEY NAME>>) 
violated.  

- Error: ORA-02275: such a referential constraint already exists in the 
table. 

- Error: ORA-01430: column being added already exists in table. 

- Error: ORA-02303: cannot drop or replace a type with type or table 
dependents. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

http://support.oracle.com/
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Oracle Financial Services Channel Analytics 
Configuration 
  

1. Make sure Oracle Business Intelligence (Version 11.1.1.6.0) installation is completed 
with patches (13742915,13388423,14003822) and available.  

 
2. Set the <Oracle BI Instance Home> directory> => e.g. 

/u01/OBIEE11G/instances/instance1.  
 

3. Start Weblogic AdminServer.   
a. Set the < BI Domain Home> directory> => e.g.  

/u01/OBIEE11G/user_projects/domains/bifoundation_domain.  
b. Navigate to < BI Domain Home >/bin and run ‘nohup ./startWebLogic.sh &’ 
c. Bringing up this service may take a few minutes depending on your 

environment.Check the logs using the command ‘tail –f nohup.out’ 
 

4. Start Node Manager.  
a. Set the < WebLogic Server Home > directory> => e.g.  

/u01/OBIEE11G/wlserver_10.3.  
b. Navigate to <WebLogic Server Home>/server/bin and  

run ‘nohup ./startNodeManager.sh &’. 
 

5. Start Weblogic Managed Server(bi_server1). 
a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 
b. Under Environment block (mid of page, towards left side), click on Servers 

link. 

 
c. The bi_server1 line should show as shutdown state at this point.  

 

 
 

d. Click on control page tab.  
 

 
e. Select the bi_server1 line by clicking on the left tick box,  
f. Click start button at the top of the list and confirm starting this service  
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g. State will update to “RUNNING” mode after a few minutes.  

 
6. Start BIEE services and login  

a. Starting services From EM screen  
i. Login to the EM administration screen using the url 

http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation 
to log in.  

ii. Expand 'Business Intelligence' node on the left and choose 
Coreapplication.  

 

 
 

iii. Click on the Overview Tab,  
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iv. Click on blue button ‘Restart’ (or green button ‘Start’ ) under the 

Manage System category, middle of screen,  
v. Click yes on dialog box to confirm the move. Wait for message that 

confirms successful restart.  
 

b. If starting using EM is not successful and complaining about OPMNCTL not 
up, please follow starting process with OPMNCTL. 

i. Open a command prompt, navigate to <Oracle BI Instance 
Home>/bin.  

ii. run “./opmnctl status, this will show you status of all the OBIEE core 
services  

iii. run “./opmnctl startall” or “./opmnctl stopall” depending on your need.  
 
 

7. Deploy RPD and webcat file(s). 
a. Navigate to folder $FIC_HOME/CRMCA/OBIEE11G/ which contains both 

CRMCA.rpd and archived CRMCA.catalog (contains the shared folder of CRMCA 
application).Copy both the files to a local folder. 

b. Login to  
I. OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 
II. Click on hyperlink ‘coreapplication’ from ‘Business Intelligence’ tab on left 

hand side. 
III. Under ‘coreapplication’, select the tab ‘Deployment’ and click ‘Lock and 

Edit Configuration’ button located below title ‘coreapplication’. Following 
screen will show up. 

 

 
 

IV. RPD Deployment: 
1. Select ‘Browse’ button available under ‘Upload BI Server 

Repository’ section and select CRMCA.rpd file from the local 
folder. Enter Repository password ‘Admin123’ 

V. Web catalog Deployment: 
1. Set the Catalog Location available under ‘BI Presentation 

Catalog’ like: 
“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServic
esComponent/$COMPONENT_NAME/catalog/CRMCA” 

2. Now Click ‘Apply’ and then Click ‘Activate changes’. A pop up will 
be shown after successful activation. 
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3. Click ‘Close’ and switch to ‘Capacity management ‘tab. 
4. Restart the presentation services. Under the ‘System 

Components Availability’, select ‘Presentation Services’ and click 
on ‘Restart Selected’ option. 

 

 
 

VI. Once the Presentation Service is restarted, it will give the pop up for 
successful restart. Click ‘Close’ 

VII. Verify that new folder structure is created in the system. It can be found 
under path: 
 <Oracle BI Instance Home> 
\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\CRMCA 

VIII. This ‘CRMCA’ folder will be having a root folder which in turn contains 
three folders named ‘shared’, ‘system’ and ‘users’. 

 
 

c. Open the Catalog Manager 
a. Go to ‘File’ and open the catalog online (File->Open catalog) by giving the 

necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics/saw.dll). 

b. Once the catalog is opened, it will display a folder structure on left hand side. 
Select the shared folder root folder in the LHS tree structure. 

c. Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file. 
d. Browse the path of the archived catalog file saved in your local folder using 

the ‘Browse’ button in the pop up. Click ‘Ok’ 
e. The catalog will be unarchived in specified location. A pop up for successful 

operation will be shown. Restart the presentation services once again. 
d. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with 

credentials based on your setup, and verify that catalog is available. 
 

8. Configure tnsnames.ora.  
a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin  
b. Make sure an entry is made in the tnsnames.ora to connect to application 

schema of OFSAA application. 
c. Save the tnsnames.ora 

  
9. Configure ODBC data source to connect to Oracle BI Server.  

 
a. Go To Control Panel>Administrative Tools>Data Sources (ODBC).  
b. Select the ‘System DSN’ tab and click ‘Add’ Button.  
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c. Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button.  
d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of 

the BI Server and click ‘Next’).  
e. Enter Oracle BI Server login id and password (Enter User Name and 

Password created at the time of OBIEE installation). Click ‘Next’.  
f. Click ‘Finish’.  

 
10. Modify connection pool and set the properties.  

a. Open the OBI Administration tool.  
b. Select Start > Programs > Oracle Business Intelligence > BI Administration.  
c. Select File > Open > Online and select ‘CRMCA.rpd’ file.  
d. In the Open dialog box, select and open ‘CRMCA.rpd’ file.  
e. Enter Repository password as ‘Administrator’.  
f. In the "Physical" layer, double-click the CRM Connection Pool under CRM 

Database to open its properties.  
g. In the ‘General’ tab, edit / check the following entries:  
h. Call Interface: (OCI 10g/11g).  
i. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA application schema>.  
j. User name: <enter application db user name>.  
k. Password: <enter application db user password>.  
l. Confirm password and Click 'OK' to close the window. 
m. Repeat the same for CRM Connection Pool (Init Block) 
n. In the "Physical" layer, double-click the CRM Connection Pool under CRM 

Essbase ‟ to open its properties.  
o. Essbase Server :< ip address/Hostname of the Essbase server>Username : 

<Essbase username> 
p. Password : <Essbase password> 
q. Confirm password and Click 'OK' to close the window and click 'Save' to save 

the RPD file.  
r. Click 'No' for the Global Consistency Message.  
s. Close the RPD file (File / Exit).  

 
11. Login into CRMCA Application using the URL: 

http://localhost:9704/analytics.(Replace the port number based on your setup). 
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Trouble shooting 
Problem: After logging into CRMCA Application, if end user experiences an error as 
“Exceeded configured maximum number of allowed output prompts, sections, rows, or 
columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 
2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 
Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 
instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 
<MaxVisibleColumns>3000</MaxVisibleColumns> 
<MaxVisiblePages>10000</MaxVisiblePages> 
<MaxVisibleRows>50000</MaxVisibleRows> 
<MaxVisibleSections>250</MaxVisibleSections> 
<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 
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OBIEE Installation and Configuration Guide Link  
Note: Refer the following link to down load the OBIEE installation and configuration guide 
document.  

http://www.oracle.com/technology/documentation/bi_ee.html
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